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ABSTRACT 

 Animations are one of multimedia 

technology which can accelerate the 

perspective about something, including the 

aircraft flight controls and landing gears 

function. Production process of animation 

on 3 Dimensional Aircraft model Supri 

Sukhoi Superjet 100 using NURBS 

Modelling method.  

 Production process of animation 

on 3 Dimensional Aircraft model Supri 

Sukhoi Superjet 100 using Pre Production, 

Production and Post Production, that the 

result can be presented in the form of 

simulation video, Flash game, and 

Powerpoint game. The special effect that 

added into model, video and game make it 

more attractive. The Results are tested on 

number of respondents who are Experts in 

the Aircraft Engineering. The Data showed 

that Almost to 100 percent of the 

components and fuctions of the aircraft. 

Keywords: Production process of 

Animation, Flight Controls and Landing 

Gears Simulation, Supri Sukhoi Superjet 

100. 

 

1. PENDAHULUAN 

 Sukhoi Superjet 100 merupakan 

pesawat transportasi penumpang yang 

menggunakan PowerJet SaM146 turbofan 

engines yang dikembangkan oleh PowerJet. 

Seperti pada umumnya pesawat, Superjet 

100 mempunyai Flight Controls atau 

pengendali terbang seperti Ailerons, 

Elevators, Rudder, Flaps dan lainnya, yang 

digunakan untuk mengendalikan 

pergerakan pesawat di darat maupun di 

udara, yang membedakannya hanya 

arsitektur yang menyesuaikan dengan 

desain pesawat itu. Setiap Flight Control 

mempunyai pergerakan yang berbeda-beda 

sesuai dengan fungsinya. Salah satunya 

membantu pergerakan Landing Gears saat 

pesawat terbang berada di darat.  

 Landing Gears merupakan 

pengendali terbang yang terletak pada 

bagian bawah pesawat yang berfungsi 

mengendalikan pesawat di darat. Salah satu 

pergerakan Landing Gears adalah pada saat 

Rectraction (Take Off) dan Extension 

(Landing). Perancangan Flight Controls 

dan Landing Gears pada jenis pesawat yang 

diberi nama Supri Sukhoi Superjet 100.

mailto:Informatika@stta.ac.id
http://en.wikipedia.org/wiki/PowerJet_SaM146
http://en.wikipedia.org/wiki/Turbofan
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Supri Sukhoi Superjet merupakan model 

3 dimensi pesawat terbang yang 

didasarkan pada desain pesawat terbang 

Sukhoi Superjet 100. Perbedaan hanya 

terletak pada desain eksterior pesawat 

terbang. 

 

2. TINJAUAN PUSTAKA 

2.1 On NURBS : A Survey 

 On NURBS : A Survey merupakan 

penelitian yang dilakukan oleh Les Piegl 

dari University of Florida pada tahun 

1991. Penelitian ini didasarkan dari 

penemuan Pierre Étienne Bézier 

mengenai NURBS yang digunakan pada 

Computer Aided Design (CAD) yang 

sangat cocok untuk dunia industri dan 

benda yang bersifat polynomial rasional. 

Penelitian ini menjadi dasar semua 

penelitian tentang NURBS termasuk 

alasan penggunaan Nurbs untuk 

pemodelan 3D (Piegl, 1991 dan Piegl 

1997). 

2.2 Pembuatan Model 3D Pesawat 

Terbang menggunakan Teknik 

NURBS Modelling pada Software 

3D Studio Max  

 Dalam penelitian terdahulu yaitu 

karya Hendi Nugroho yang membahas 

tentang pemodelan NURBS pesawat 

terbang yang menghasilkan 3D pesawat 

Boeing salah satu airline swasta di 

Indonesia (Nugroho, 2011). 

 

3. METODE PENELITIAN 

3.1 Modelling 

 Modelling adalah pembuatan 

model-model atau obyek-obyek yang 

berperan dalam animasi (Gunawan, 

2013). Dalam penelitian ini, model 

pesawat Supri Sukhoi Superjet 100 

lengkap dengan pengendali terbang 

(flight controls), alat pendaratan (landing 

gears) menggunakan teknik NURBS. 

 Untuk referensi atau pedoman 

model Supri Sukhoi Superjet 100, 

menggunakan blueprint  Sukhoi Superjet 

100 dari theblueprint.com. Kemudian 

jadikan blueprint  menjadi latar belakang 

dari model yang akan dibuat dengan cara 

centang Background Image > Klik ADD  

Image > Klik Open > Pilih Blueprint  

Sukhoi Superjet 100.jpg ( lebih jelasnya 

dapat dilihat Gambar 1). 
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Gambar 1. Posisi Membuat gambar 

Latar belakang 

 

 Hampir keseluruhan modelling 

menggunakan metode NURBS, teknik 

extrude, dan transformasi. Pembuatan 

model dengan teknik NURBS, dilakukan 

pada menu Add > Surface > NURBS 

Circle atau shift+A > Surface > Nurbs 

Circle. Kemudian atur posisinya sesuai 

dengan blueprint untuk mempermudah 

dalam pemodelanPembuatannya 

menggunakan teknik Extends dengan 

cara tekan Tab keyboard unuk 

memindahkan mode dari Object mode ke 

Edit Mode. Pilih titik-titik atau surface 

NURBS kemudian tekan E atau pada 

Tools, lalu tarik sampai ke ekor pesawat. 

Extrude kembali sampai ke bagian 

kokpit. Atau pada layar sebelah kanan 

ada tombol Extrude (Flavell, 2010 dan 

Soekahar, 2004). Posisinya pada Blender 

3D dapat dilihat pada Gambar 2. 

Tahapan pembuatan badan pesawat 

dengan metode dan teknik modelling 

dapat dilihat pada Gambar 3. Setelah jadi 

seperti pada Gambar 4, beri nama 

Fuselage pada obyek properties. 

 

Gambar 2. Metode NURBS Surface, 

dan Surface tools 
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A B

C

 

Gambar 3. Penerapan metode dan 

teknik NURBS modelling pada 

Fuselage 

 

 

Gambar 4. Hasil jadi Modelling 

lengkap 

 

 Perlengkapan pendaratan dapat 

dilakukan pembuatan model dengan 

memisahkan parts antara bedasarkan 

fungsi dan namanya sesuai desain dan 

seperti yang terlihat pada Gambar 5, ini 

dilakukan untuk memperluas animasi 

atau pergerakan yang dapat dibuat. 

Bagian rodanya menggunakan Surface 

Nurbs Torus, kemudian ditambahkan 

modifier Mirror, dan set Origin diantara 

kedua roda. Untuk pipa penyangga alat 

pendarat, gunakan Surface Nurbs 

Cylinder, Scale, Extrude, transformasi 

sehingga menjadi seperti desain yang 

sudah ditetapkan. 

 

Gambar 5. Desain Landing Gears 

 

 Pembuatan pengendali terbang 

lakukan pemisahan sementara pada 

sayap utama dengan bagian lainnya 

untuk mempermudah dalam 

memodifikasi. Pada Edit Mode, lakukan 

subdivide untuk mendapatkan lebih 
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banyak titik dan kurva (seperti yang 

terlihat pada Gambar 6 A) untuk 

dimodifikasi menjadi flaps, slats, 

Ailerons, maupun Spoilers. Tarik titik-

titik dan kurva yang mendekati ke garis 

rancangan flaps, slats, Ailerons, maupun 

Spoilers yang nantinya akan di duplikat 

dan di trim sehingga terpisah dan 

menjadi obyek baru (gambaran 

prosesnya dapat dilihat pada Gambar 6). 

A B

C

D

 

Gambar 6. Tahapan pemakaian 

subdivide dan pengaturan titik-titik 

sayap utama 

 

3.2 Texturing 

 Texturing merupakan proses 

pemberian tekstur, warna maupun desain 

ke obyek. Untuk penelitian ini 

menggunakan metode UV Maps. UV 

maps atau Mapping merupakan sebuah 

proses pembuatan representatif gambar 

dua dimensi ke obyek tiga dimensi. 

Butuh banyak pengaturan agar hasil 

Texturing dapat keluar atau terlihat pada 

saat Rendering (Gunawan, 2013). 

 Selanjutnya pengaturan pada 

Properties Material dan Textures. Pada 

Material bebas menerapkan warna dasar 

apa aja, yang terpenting di pemberian 

dan pemilihan warna Material. Setelah 

melakukan pengaturan Material, 

langsung ke pengaturan Textures karena 

mereka akan saling terhubung.pada 

Textures beri nama Textures, set type 

Image or Movie, show Alpha. Pada 

Image, pilih file tekstur gambar 2D yang 

dipakai pada obyek. Pada Color Space, 

set View as Render. Pada Mapping, set 

Coordinates sama dengan UV, Map 

sama dengan UV Maps. Untuk gambar 

UV dan nama Textures maupun 

Materials sesuaikan dengan nama bagian 

pesawat. 
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3.3 Rigging 

 Rigging merupakan sebuah teknik 

dalam animasi komputer dimana proses 

penulangan, pemberian tulang yang 

saling terhubung berfungsi untuk 

mempermudah dalam menggerakkan 

obyek (animate). Rigging dalam obyek 

penelitian pesawat SSSJ100 adalah 

berupa dasar dan tulang untuk 

pergerakan animasi pengendali terbang. 

Rigging akan dietakkan pada Layer 2. 

Selanjutnya akan dilakukan proses 

menghubungkan dengan teknik 

Parenting (Object > Parent > Object 

atau Ctrl+P) . Pilih Object (keep 

Transform) untuk menghubungkan 

antara dua atau lebih obyek namun tanpa 

merubah posisi obyek manapun agar 

tidak terjadi perubahan posisi yang tidak 

diinginkan yang akan membuat 

berantakan semua posisi obyek. 

 

3.4 Controller 

 Tahapan  tambahan, berupa 

pemberian tulisan yang dapat digerakkan 

sesuai fungsinya yang akan pengendali 

dari obyek yang dapat digerakkan dari 

SSSJ100 ini. Nanti dilakukan Lock 

Location, Scale dan Rotation untuk 

mengunci spesifikasi pergerakan 

pengendali. Controller akan diletakkan 

pada Layer 5. 

 

3.5 Animating 

 Animating merupakan proses 

mengatur pergerakan obyek sehingga 

menjadi obyek bergerak yang diingikan. 

Proses Animating untuk video simulasi 

komunikatif pesawat SSSJ100 dilakukan 

terpisah setiap bagiannya sesuai scene 

yang diperlukan seperti ShowOff 

SSSJ100, Hangar Rudder, Fly Aileron 

dan lainnya. Ini dilakukan untuk 

menghindari beratnya penyimpanan file 

blender, beratnya proses rendering dan 

mempermudah dalam proses 

penyuntingan setiap scene yang ingin 

dibuat. Selanjutnya cara bagaimana 

mengunci obyek pada suatu keyframe 

dengan cara Properties Object Tool (key 

T) Insert Keyframe, pilih jenis pengunci 

seperti location, location rotation 

(LocRot), dan lainnya yang mempunyai 

fungsi sesuai namanya. Sedangkan 

Available berfungsi sebagai pengunci 

dengan jenis kunci yang sudah 

ditetapkan sebelumnya, jika sebelumnya 

dikunci pada LocRot maka untuk 

keyframe selanjutnya, tinggal memilih 
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Available untuk mengunci obyek pada 

frame tertentu. 

 

3.6 Lighting 

 Lighting merupakan proses 

pengaturan posisi cahaya, jumlah 

cahaya, ukuran cahaya, warna, kekuatan 

cahaya dan lainnya. Pencahayaan buatan 

berjumlah yang terdiri dari Frontlight, 

LeftLight, LightCam, RightLight, 

Spotlight, Spotlight.backL, 

Spotlight.backR, Spotlight.topL, 

Spotlight.topR dan Sunny. Frontlight 

merupakan cahaya jenis Spot yang 

digunakan untuk pencahayaan ke depan 

bagian pesawat termasuk perlengkapan 

pendaratan (Currey, 1988 dan Raymond, 

1993). LeftLight merupakan cahaya jenis 

hemi yang digunakan untuk pencahayaan 

dalam hanggar bagian kiri. LightCam 

merupakan cahaya jenis Spot yang 

digunakan untuk pemberi cahaya untuk 

kamera. RightLight merupakan cahaya 

jenis hemi yang digunakan untuk 

pencahayaan dalam hanggar bagian 

kanan. Spotlight merupakan cahaya jenis 

spot yang digunakan untuk memberi 

cahaya khusus ke pesawat. 

Spotlight.backL merupakan cahaya jenis 

spot yang digunakan untuk memberi 

cahaya khusus ke pesawat dari kiri atas. 

Spotlight.topL merupakan cahaya jenis 

spot yang digunakan untuk memberi 

cahaya khusus ke pesawat dari kiri atas. 

Spotlight.backR merupakan cahaya jenis 

spot yang digunakan untuk memberi 

cahaya khusus ke pesawat dari kanan 

belakang. Spotlight.topR merupakan 

cahaya jenis spot yang digunakan untuk 

memberi cahaya khusus ke pesawat dari 

kanan atas. Sunny merupakan cahaya 

jenis sun yang digunakan untuk memberi 

cahaya seperti cahaya matahari yang 

diposisikan diluar hanggar dengan 

penambahan sky pada sky & 

Atmosphere. 

 

3.7 Rendering 

 Proses ini merupakan proses 

konversi dari wireframe digital poligon 

menjadi bentuk gambar. Proses 

rendering untuk video simulasi 

komunikatif pesawat SSSJ100. 

Pengaturan rendering dapat dilakukan 

pada menu Properties Render. Render 

akan dilakukan setiap file blender yang 

sudah dibuat bedasarkan adegan 

pergerakan atau Animation yang ada dan 

sesuai dengan pengaturan pada proses 

Animating di atas. Untuk pengaturan 
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keseluruhan, mengunnakan Light adalah 

Lights berupa grup semua cahaya yang 

sudah ditetapkan. 

 

3.8 Editing 

 Editing adalah proses memilih dan 

menyiapkan tertulis, visual, terdengar, 

dan media film digunakan untuk 

menyampaikan informasi atau dalam 

bahasa singkatnya editing merupakan 

proses penyuntingan dan penyusunan 

gambar atau video, audio atau suara dan 

teks. Proses editing dapat melibatkan 

koreksi, kondensasi, organisasi, dan 

modifikasi lainnya yang dilakukan 

dengan maksud menghasilkan, 

konsisten, akurat, dan lengkap pekerjaan 

yang benar (Gunawan, 2013). Pada 

penelitian ini, menggunakan perangkat 

lunak Blender Video Editor dan Avid 

Studio. 

 

3.9 Compositing 

 Compositing merupakan 

penggabungan dari berbagai gambar 

termasuk latar belakang dan latar depan. 

Editing merupakan proses penyusunan 

gambar dan music menjadi suntingan 

video yang utuh. Mastering merupakan 

proses penyatuan semua bagian dari 

proses editing yang masuk proses 

rendering menjadi video utuh dengan 

Audio, Video, Texts, Sound FX, Music 

dan lainnya. Penyatuan video simulasi 

emnggunakan Avid studio dengan 

pengaturan Export, set File Setting Type 

AVI, Preset Full Screen (DV) lalu klik 

Start Export. 

 

4. IMPLEMENTASI 

4.1.1 Penjelasan Hasil Rancangan 

Animasi 

4.1.2 Video Simulasi SSSJ100 

 Video simulasi SSSJ100 

memberikan gambaran cara kerja 

pengendali terbang dan perlengkapan 

pendaratan pada pesawat. Video simulasi 

dibuat sekreatif, seinovatif dan 

semenarik mungkin dengan penerapan 

multimedia. Dengan adanya video 

simulasi ini, akan mempercepat dan 

memperkuat pemahaman mengenai 

pesawat pada umumnya dan Supri 

Sukhoi Superjet 100 pada khususnya. 

 Pembuatan video simulasi ini, 

sudah dibahas pada perancangan dan 

pembuatan animasi  yang screenshot 

hasilnya dapat dilihat pada Gambar 7. 
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4.1.3 Flash Game Simulasi SSSJ100 

 Game simulasi SSSJ100  yang 

pertama dibuat menggunakan adobe 

flash yang nantinya akan memberikan 

gambaran cara kerja pengendali terbang 

dan perlengkapan pendaratan pada 

pesawat. Game itu harus bersifat 

interaktif dimana diberikan button atau 

tombol dan fungsi keyboard sebagai 

fungsi yang mengatur permainan. 

 Pembuatan flash game ini dimulai 

dengan membuat project baru bernama 

SSSJ100Flash dengan cara klik menu 

File > New (Ctrl+N), kemudian pilih 

Flash File (ActionScript 3.0). Lakukan 

perubahan layer dari frame rate (FPS = 

25) dan ukuran (1024x800) melalui 

properties. 

 Ada dua teknik yang digunakan 

antara lain: 

a. Grafik interaktif dengan tombol 

timeline 

 Gambaran umum dari teknik grafik 

interaktif dengan tombol timeline adalah 

munculnya penjelasan tentang gambar 

atau grafik yang ditunjuk oleh kursor. 

Contohnya, jika kursor diarahkan pada 

badan pesawat (fuselage) maka akan 

muncul tulisan penjelasan mengenai 

badan pesawat. 

 Tekniknya dimulai dengan 

membuat obyek 2D menyerupai dengan 

obyek gambar yang ingin dibuat grafik 

interaktif. Contohnya jika ingin 

membuat tombol interaktif rudder, maka 

buat obyek 2D menyerupai bentuk 

rudder, dengan cara menambahkan 

obyek segi empat (Rectangle Tool or 

Rectangle Primitive Tool) atau segi lima 

(PolyStar Tool) pada tools yang 

kemudian dapat dirubah atau 

dimodifikasi sesuai keinginan dengan 

meng-klik dua kali (masuk edit mode). 

Lakukan perubahan pada Fill and Stroke, 

no outline (tanpa garis), 10% blue 

(transparan 10% biru). Setelah obyek 

jadi, lakukan konversi ke button symbol 

dengan cara klik kanan > Convert to 

Symbol… > pilih tipenya “button” dan 

beri nama tombolnya (contoh 

rudder_btn). 

 Di Timeline akan ada Up dan 

Over. Up digunakan apabila akan 

ditampilkan setiap saat, sedangkan Over, 

akan ditampilkan setiap kursor 

menyentuh obyek. Maka tambahkan 

keyframe pada frame Over dengan cara 

klik kanan pada framenya, pilih Insert 

Keyframe. Pada frame ini, tambahkan 

tulisan sesuai keinginan (di penelitian 
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ini, hanya memberikan ide pokok dari 

pengertian obyek) contoh pada rudder 

frame Over, diberikan tulisan judul 

Rudder dengan penjelasan, “ The rudder 

is a fundamental control surface. It is the 

primary means of controlling yaw--the 

rotation of an airplane about its vertical 

axis. 

(more information press R).” kemudian 

tambahan garis penunjuk dari obyek ke 

tulisan. Dengan ini jadilah grafik 

interaktif dengan tombol timeline. 

b. Memutar video eksternal secara 

sederhana 

 Memutar video external secara 

sederhana dapat dilakukan dengan 

mudah dengan cara menarik video 

(FLV), atau menu > File > Import > 

Import to Stage atau Import Video. 

Kemudian akan tampil jendela 

pengaturan Import Video, pilih Load 

External video with playback 

component. Selanjutnya tentukan 

skinning dari komponen pemutar video, 

lalu klik next dan finish. Maka 

komponen pemutar video akan tampil di 

layar. Lakukan pengaturan posisi (X = 0 

, Y = 0) dan ukuran (1024x800) 

komponennya. Kemudian buat layer 

dengan klik New Layer pada jendela 

Timeline yang dibuat sebanyak 18. Ke 

delapan belas layer yang diberikan 

grafik interaktif mengenai pengertian, 

video simulasi  sesuai nama layer 

kecuali layer 14 sampai 19 seperti 

berikut : Rudder (1), Ailerons (2), Fin 

(3), Elevators (4), Cockpit (5), 

BackWings (6), Slats (7), Spoilers (8), 

Flaps (9), LandinGears (10), JetEngines 

(11), Wings (12), Fuselage (13). 

 Layer Texts (14) merupakan 

tempat membuat judul permainan, 

tentang (About) permainan dengan grafik 

interaktif dengan tombol timeline dan 

informasi mengenai kunci pengendali 

menjalankan video simulasi keseluruhan 

SSSJ100. 

 Layer Titles (15) merupakan 

tempat membuat grafik interaktif dengan 

tombol timeline pada frame ke 53 

tentang jenis pesawat. Tambahkan 

tulisan “SSSJ100,” kemudian beri nama 

setelah konversi ke tombol dengan nama 

sssj100 _btn. Kemudian berikan tulisan , 

“Supri Sukhoi Superjet 100. ForMore 

information press Z.” 

 Layer  Buttons (16) merupakan 

tempat membuat beberapa tombol 

seperti mulai (Start), layar penuh 
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(Fullscreen), layar normal, musik1 dan 

musik2. 

 Layer  Images (17) merupakan 

tempat meletakkan beberapa gambar 

yang nantinya akan digerakkan. 

 Layer Scripts (18) merupakan 

tempat memberikan script yang akan 

berpengaruh pada beberapa frame. Script 

akan dibagi menjadi empat bagian. 

Pertama, dimulai dari frame 1 sampai 

frame 52 untuk adegan menu utama, 

animasi membuka pintu hanggar, masuk 

ke dalam hanggar , fungsi tombol Start, 

Exit, Fullscreen, Normal, musik1 dan 

musik2. Kedua, pada frame 53, klik 

kanan Insert Blank Keyframe adegan 

hanggar, menghentikan pergerakan 

frame, fungsi keyboard untuk video 

simulasi setiap bagian. Ketiga, dari 

frame 54 (Insert Blank Keyframe) 

sampai frame 62 untuk adegan 

menghentikan musik dan fungsi tombol 

kembali ke hanggar. Keempat, dari 

frame 63 sampai frame 113 untuk 

adegan menutup pintu hanggar dan 

kembali ke menu utama.  

 Layer All (19) merupakan tempat 

memberikan script yang akan 

berpengaruh pada keseluruhan frame. 

Pada layer ini, diberikan script untuk 

fungsi menghilangkan tampilan menu, 

klik kanan dan posisi yang dapat 

menyesuaikan dengan layar. 

 Simpan proyek permainan flash 

pada Menu > File > Save (Ctrl+S), 

kemudian dilakukan pengujian atau Test 

Movie pada Menu > Control  > Test 

Movie (Alt+Enter). Test movie juga akan 

langsung membuat game flash dengan  

format .swf  yang dapat dimainkan atau 

diputar di browser yang mempunyai 

adds on adobe flash player maupun 

adobe flash player. Beberapa gambar 

hasil permainan flash dapat dilihat pada 

Gambar 7. 

4.1.4 Powerpoint Game Simulasi 

SSSJ100 

 Game simulasi SSSJ100  yang 

kedua akan dibuat menggunakan 

powerpoint dimana akan diberikan 

button sebagai fungsi yang mengatur 

permainan ini. Tombol pengendali slide 

presentasi permainan menggunakan 

hyperlink untuk menghubungkan antara 

slide satu dengan slide lainnya. 

Hyperlink dapat dilakukan dengan cara 

klik kanan pada obyek yang akan 

diberikan hyperlink, kemudian pilih 

hyperlink > Place in this Document. 
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Kemudian pilih slide yang dituju, lalu 

klik OK. 

 Ada 12 slides yang diberi nama 

pada title slide sebagai berikut : 

1. Supri Sukhoi Superjet 100, Pada 

slide Supri Sukhoi Superjet 100 ini, 

merupakan slide pertama yang berisi 

tentang judul powerpoint, beserta dengan 

perkenalan. Pada kotak title, tulis “Supri 

Sukhoi Superjet 100.” Pada kolom 

subtitle, tulis “Made by Ermanto Supri.” 

2. Supri Sukhoi Superjet 100 Menu, 

Slide Supri Sukhoi Superjet 100 Menu 

berisi tombol pengendali yang akan 

dijelaskan dalam Tabel 1. 

3. FullMovie SSSJ100, Slide 

FullMovie SSSJ100 merupakan slide 

yang berisi video animasi Supri Sukhoi 

Superjet 100.mp4 yang akan dimainkan 

otomatis saat slide aktif. 

4. Around SSSJ100 Movie, Slide 

Around SSSJ100 Movie merupakan slide 

yang berisi video animasi 

AroundSSSJ100.avi yang akan 

dimainkan otomatis saat slide aktif. 

5. Take Off, Slide Take Off 

merupakan slide yang berisi video 

animasi TakeOff.avi yang akan 

dimainkan otomatis saat slide aktif. 

6. Landing & Taxi, Slide Landing & 

Taxi merupakan slide yang berisi video 

animasi LandingTaxi.avi yang akan 

dimainkan otomatis saat slide aktif.  

7. Rudder, Slide Rudder merupakan 

slide yang berisi video animasi 

RudderShow.avi yang akan dimainkan 

otomatis saat slide aktif.  

8. Elevators, Slide Take Elevators 

merupakan slide yang berisi video 

animasi ElevatorShow.avi yang akan 

dimainkan otomatis saat slide aktif.  

9. Ailerons, Slide Ailerons 

merupakan slide yang berisi video 

animasi AileronShow.avi yang akan 

dimainkan otomatis saat slide aktif.  

10. FlapSlats, Slide FlapSlatShow 

merupakan slide yang berisi video 

animasi FlapSlatShow.avi yang akan 

dimainkan otomatis saat slide aktif. 

11. Spoilers, Slide Spoilers merupakan 

slide yang berisi video animasi 

SpolierShow.avi yang akan dimainkan 

otomatis saat slide aktif.  

12. Bye, Slide Bye adalah slide 

perpisahan. 

 

 Tampilan gambar-gambar 

permainan Powerpoint ini dapat dilihat 

pada Gambar 7. 

104 



113 

 

 

 

 

 

Gambar 7. Screenshot Video simulasi, 

permainan flash dan powerpoint 

SSSJ100 

 

4.2 Analisa Animasi 

 Pengujian pergerakan Flight 

Controls dan Landing Gears agar sesuai 

dengan yang sebenarnya, maka 

dilakukan pengambilan data melalui 

kuesioner kepada 10 responden yang ahli 

di bidang pesawat terbang antara lain: Ir. 

Djarot Wahyu Santosa, M.T, 

Mohammad Ardhi Cahyono,  S.T., M.T., 

Basir, S.T., M.Eng., M.Sc., Bangga D.A, 

S.T., M.T. Karseno.KS, Inz, S.E.,M.M., 

Subardjo, S.E., Aznil, S.T., Arief Adi 

Nugroho, S.T., Muhammad Takdir, S.T, 

Nasruddin, S.T. Kemudian diberikan 

Kuesioner dengan 8 pertanyaan yang 

kesamaan atau tidaknya pergerakan 

fungsi Flight Controls dan Landing 

Gears pada model 3D pesawat terbang 

Supri Sukhoi Superjet 100. Dari 

kedelapan pertanyaan dan diajukan ke 

sepuluh responden didapatkan hasil 53 

pertanyaan mendapatkan jawaban „Ya‟, 

7 pertanyaan mendapatkan jawaban 

„Tidak‟ atau kurang, dan tidak ada yang 

menjawab „Tidak Tahu‟ untuk 

pertanyaan tentang fungsi Flight 

Controls.  Fungsi Landing Gears 

mendapatkan hasil 20 pertanyaan 

mendapatkan jawaban „Ya‟,  tidak ada 

yang menjawab „Tidak‟ atau kurang, dan 

tidak ada yang menjawab „Tidak Tahu‟. 

Untuk lebih jelasnya dapat dilihat pada 

Tabel 1, grafik analisa persamaan 

simulasi fungsi Flight Controls dapat 

dilihat pada Gambar 8 dan grafik analisa 

persamaan simulasi fungsi Landing 

Gears dapat dilihat pada Gambar 8.  
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 Bedasarkan grafik analisa 

persamaan simulasi fungsi Flight 

Controls, didapatkan hasil 88.33 persen 

menjawab „Ya‟ atau sama, 12.67 persen 

menjawab „Tidak‟ atau kurang dan nol 

persen yang menjawab „Belum Tahu‟.  

Grafik analisa persamaan simulasi fungsi 

Landing Gears, didapatkan hasil 100 

persen menjawab „Ya‟ atau sama, nol 

persen menjawab „Tidak‟ atau kurang 

dan nol persen yang menjawab „Belum 

Tahu‟. 

 

Tabel 1.Hasil Kuesioner Analisa 

Simulasi SSSJ100 

Jawaban/Perta

nyaan 
1 2 3 4 5 6 7 8 

Ya 9 1 9 9 9 7 1 1 

Tidak 1 - 1 1 1 3 - - 

Belum tahu - - - - - - - - 

 

Gambar 8. Grafik persentase analisa 

persamaan simulasi Fungsi Flight 

Controls dan Landing Gears SSSJ100 

 

5. KESIMPULAN DAN SARAN 

5.1 Kesimpulan 

 Kesimpulan yang diperoleh dari 

hasil penelitian pembuatan animasi 

simulasi pergerakan Flight Controls dan 

Landing Gears adalah sebagai berikut: 
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1. Gerakan Flight Controls pada 

model 3D pesawat terbang Supri Sukhoi 

Superjet 100 sudah sesuai dengan fungsi 

pada pesawat terbang. 

2. Gerakan Flight Landing Gears 

pada model 3D pesawat terbang Supri 

Sukhoi Superjet 100 sudah sesuai 

dengan fungsi pada pesawat terbang. 

3. Model 3D pesawat terbang Supri 

Sukhoi Superjet 100 menggunakan 

metode NURBS Modelling dalam proses 

produksinya. 

 

5.2 Saran 

1. Model 3D pesawat terbang Supri 

Sukhoi Superjet 100 dapat 

dikembangkan untuk mensimulasikan 

gerakan Take Off, Landing dan Supri 

Sukhoi Superjet 100 flight simulator. 

2. Bugs atau kesalahan dapat 

diperbaiki pada permainan Flash dimana 

video eksternal belum bisa dimatikan 

sejalan dengan pergantian frame, jika 

kembali atau ke frame lainnya tanpa 

mematikan video, maka video akan tetap 

menyala dengan musiknya yang sangat 

mengganggu untuk proses lainnya. 
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